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1

1 Introduction

1.1 Add-onModule RF-/TIMBER NBR

The Standard NBR 7190 - Design of wooden structures [1] provides general rules that must be
followed for the design, construction and analysis of timber in Brazil. With the add-on modules
RF-TIMBER NBR (for RFEM) and TIMBER NBR (for RSTAB), DLUBAL provides powerful tools for the
design of timber beammodels according to this standard.

In the following, the add-on modules of both main programs are described in one manual and
are referred to as RF-/TIMBER NBR.

RF-/TIMBER NBR performs all cross-section resistance designs, optional stability analyses, and
deformation analyses according to the standard [1]. For the stability analysis, additional bending
moments from geometric imperfections (defined by a set of eccentricities) are considered. Alter-
natively, when imperfections are defined manually in RFEM or RSTAB and a second order analysis
is performed, the design is possible without a stability analysis.

For timber models, the serviceability limit state can be important for the design. For this, it is
possible to assign load cases, load and result combinations to different design situations. The
limit deformations are preset by the standard and can be adjusted, if necessary. In addition, it
is possible to specify reference lengths and precambers that are considered accordingly in the
design.

The add-onmodule provides an automatic cross-section optimizationwith the possibility to export
modified cross-sections to RFEM or RSTAB. Separate design cases allow for the flexibility to analyze
individual structural components in complex structures.

Like other add-on modules, RF-/TIMBER NBR is completely integrated in RFEM or RSTAB. Thus, the
design-relevant input data is preset when you open the module. Thus, the design-relevant input
data is preset when you start the add-on module. After the design, you can use the graphical
user interface of the main program to evaluate the results. As they are also included in the global
printout report, the entire verification can be presented in a consistent and appealing form.

We hope you will enjoy working with RF-/TIMBER NBR.

Your DLUBAL team

1.2 Using theManual

Topics like installation, graphical user interface, results evaluation, and printout are described in
detail in the manuals of the main programs RFEM and RSTAB. The present manual focuses on
typical features of the RF-/TIMBER NBR add-on module.

The descriptions in this manual follow the sequence and structure of the module's input and
results windows. In the text, the described buttons are given in square brackets, for example
[View mode]. At the same time, they are pictured on the left. Expressions appearing in dialog
boxes, windows, and menus are set in italics to clarify the explanations.

At the end of the manual, you can find the index. If you cannot find what you are looking for, go
to the Knowledge Base where you can search for the solution of the problem. Or consult the FAQs
on our website.

https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base
https://www.dlubal.com/en/support-and-learning/support/faq
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1.3 Open RF-/TIMBER NBR

RFEM and RSTAB provide the following options to start the RF-/TIMBER NBR add-on module.

Menu
To start the program in the RFEM or RSTAB menu bar, click

Add-onModules → Design - Timber → RF-/TIMBER NBR.

Figure 1.1: Menu Add-onModules→Design - Timber→ RF-TIMBER NBR

Navigator
As an alternative, you can start the add-on module in the Data navigator by clicking

Add-onModules → RF-/TIMBER NBR.

Figure 1.2: Data navigator: Add-onModules→ RF-TIMBER NBR

Panel
If results fromRF-/TIMBERNBR are already available in themodel, you can open the add-onmodule
in the panel. Set the relevant RF-/TIMBER NBR design case in the load case list of the RFEM/RSTAB
toolbar first.

Make sure that the button is active so that the design results and the panel are shown. Then
click the [RF-/TIMBER NBR] button in the panel to open the module.
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2 Input Data
When you have started the add-on module, a new window opens. In this window, a Navigator is
displayed on the left, managing the windows that can be currently selected. The drop-down list
above the navigator contains the design cases (see Chapter 7.1, page 48).

The data relevant for the design is to be defined in several input windows. When you start RF-/TIM-
BER NBR for the first time, these parameters are imported automatically:

• Members and sets of members

• Load cases, load and result combinations

• Materials

• Cross-sections

• Effective lengths

• Internal forces (in background, if calculated)

To select a window, click the corresponding entry in the navigator. To set the previous or next
input window, use the buttons shown on the left. You can also use the function keys to select the
next [F2] or previous [F3] window.

To save the results, click [OK]. Thus, you quit RF-/TIMBER NBR and return to RFEM or RSTAB. To exit
the module without saving any changes, click [Cancel].

2.1 General Data

In the 1.1 General DataWindow, you select the members, sets of members and actions for the
design. The two tabs manage the load cases, load and result combinations for the different types
of design.

Figure 2.1: Window 1.1 General Data
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Design of

Figure 2.2: Design of members and sets of members

The design can be carried out forMembers as well as for Sets of Members. If you want to design
only selected objects, clear the All check box. Then you can access the text boxes to enter the
numbers of the relevant members or sets of members. The [Delete] button clears the list of preset
numbers. The [Select] button enables you to define the objects graphically in the work window of
RFEM or RSTAB.

When you design a set of members, the program determines the extreme values of the analyses
of all members contained in the set of members and takes into account the boundary conditions
of connected members for the stability analysis. The results are shown in Windows 2.3 Designs by
Set of Members, 3.2 Governing Internal Forces by Set of Members, and 4.2 Parts List by Set of Members.

Click [New] to create a new set of members. The dialog box that you already know from RFEM or
RSTAB appears. There you can specify the parameters of the set of members.

Comment

Figure 2.3: User-defined comment

In this text box, you can enter user-defined notes describing, for example, the currently selected
design case.
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2.1.1 Ultimate Limit State

Figure 2.4: Window 1.1 General Data, tab Ultimate Limit State

Existing Load Cases and Combinations
This column contains all load cases, load combinations, and result combinations that were created
in RFEM or RSTAB.

To transfer selected items to the Selected for Design list on the right, click . Alternatively, you
can double-click the items. To transfer the complete list to the right, click .

To select several items at once, click them while pressing the [Ctrl] key – as common for Windows
applications.

A load case highlighted in red, like LC3 in Figure 2.4, cannot be designed: This happens when the
load case is defined without any load data, or if the load cases contain only imperfections. When
you transfer this load case, a warning will be shown.

At the end of the list, some filter options are available. They help you assign the items by load case,
load combination, or action category. The buttons next to the box have the following functions:

Selects all load cases in the list

Inverts the selection of load cases

Table 2.1: Buttons in the Ultimate Limit State tab

Selected for Design
The column on the right lists the load cases, load combinations, and result combinations selected
for design. To remove an item from the list, click or double-click the item. To transfer the
entire list to the left, click .

Result combination

The design of an enveloping max/min result combination is faster than the design of all con-
tained load cases and load combinations. In RF-/TIMBER NBR, however, only result combinations
consisting of “permanent” load cases that are combined with the “OR” criterion can be designed.
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2.1.2 Serviceability Limit State

Figure 2.5: Window 1.1 General Data, tab Serviceability Limit State

Existing Load Cases and Combinations
This section lists all load cases, load and result combinations that were created in RFEM or RSTAB.

Selected for Design
Load cases, load combinations, and result combinations can be added or removed as described in
Chapter 2.1.1.

It is possible to assign different deformation limits for the deflection to the individual load cases,
load and result combinations. These deformation limits are available for usual constructions
(Permanent and live actions) and constructions with non-structural fragilematerials (Total deflection
(including creep), Only variable actions) as well as for Vibration Design.

You can allocate the design situation via the drop-down list that you can open by clicking at
the end of the text box.

Figure 2.6: Selecting design situtation

The limit values of the deflections are controlled by the settings in the Standard dialog box (see
Figure 3.3, page 27). To adjust those values, click the [Standard] button..

In the 1.9 Serviceability DataWindow, the reference lengths relevant for the deformation check
are to defined (see Chapter 2.9, page 24).

For the serviceability limit state design, the effective modulus of elasticity, Ec0,ef should be used.
However, all modification factors that are defined for the design of RF-/TIMBER NBR are not used
in the calculation of RFEM/RSTAB. Therefore, it is necessary to define the final modification factor
also in the calculation parameters of the relevant load case or load combination.
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2.1.3 Standard

To check and, if necessary, adjust the default parameters, click the [Standard] button in any input
window. The Standard dialog box appears. It consists of three tabs.

Modification Factors

Figure 2.7: Dialog box Standard, tabModification Factors

In the three sections of this tab, you can check or change theModification Factors, kmod,1, kmod,2,
and kmod,3, if necessary.

The buttons in the Standard dialog box are reserved for the following functions:

Button Function

Resets the default settings of the program

Imports user-defined default settings

Saves the current settings as default

Table 2.2: Buttons in the Standard dialog box

Other Settings
In the second tab of the Standarddialog box, you findother factors significant for the design: Safety
Factor of Resistance for Ultimate Limit State, Creep Coefficient, Factors for LTB Design and Interaction
Factor. These factors can also be modified, if necessary. Furthermore, the parameters of the
Deformation Limits and Vibration Design are indicated.
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Figure 2.8: Dialog box Standard, tab Others

Used Standards
The third tab of the Standard dialog box informs you about the Standards according to which the
design is performed.

Figure 2.9: Dialog box Standard, tab Used Standards
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2.2 Materials
The window is divided into two parts: The upper table lists all materials created in RFEM or RSTAB.
TheMaterial Properties section below shows the characteristics of the current material, i.e. the row
currently selected in the upper table.

Figure 2.10: Window 1.2 Materials

Materials that will not be used in the design appear gray in color. Materials that are not allowed
are highlighted in red. Modified materials are displayed in blue.

The material properties required to determine the internal forces (Main Properties) are described
in Chapter 4.3 of the RFEMmanual and Chapter 4.2 of the RFEMmanual. The material properties
required for design (Additional Properties) are stored in the global material library. These values
are preset.

To adjust the units and decimal places of the material properties and stresses, select Settings→
Units and Decimal Places from the menu bar of the module (see Chapter 7.3, page 52).

Material Description
The materials defined in RFEM or RSTAB are preset, but you can always modify them: To select a
material, click the description in column A. Then click or press function key [F7] to open the list
of materials.

Figure 2.11: List of materials

According to the design concept of the NBR 7190:1997 [1], the list includes only materials of the
NBR standard group.



2 Input Data

©DLUBAL SOFTWARE 2017

12

2
When you have imported a material, the design relevantMaterial Properties are updated.

If you change the material description manually and the entry is stored in the material library,
RF-/TIMBER NBR imports the material properties, too.

It is not possible to edit the material properties in the add-on module RF-/TIMBER NBR.

Type of Timber
Solid Timber is the default type of timber, but it is possible to change it to Glued Laminated Timber,
Plywood or Particle Board: To select, click the type of timber in column B. Then click or press [F7]
to open the list of types. The type of timber type is important for the modification factors that are
applied in the design.

Material Library
Many materials are available in the library. To open theMaterial Library, select on the menu

Edit → Material Library

or click the corresponding button.

Figure 2.12: Dialog boxMaterial Library
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In the Filter section, NBR 7190:1997 is the default Standard. Select the material quality that you
want to use for the design in theMaterial to Select list. You can check the corresponding properties
in the dialog section below.

Click [OK] or press [ ] to transfer the selected material to Window 1.2 of RF-/TIMBER NBR.

Chapter 4.3 of the RFEM manual and Chapter 4.2 of the RSTAB manual describe in detail how
materials can be filtered, added, or rearranged.

Material Properties
In the lower section of Window 1.2, the characteristic strengths for tension, ft0,k, compression, fc0,k,
shear and torsion, fv0,k, as well as other material properties are specified.

The design values of the material strengths are, as shown for example in [1] Chapter 7.2.6, to be
determined with the modification factors kmod and the safety factors of resistance 𝛾w.

fwd = kmod ⋅ fwk
𝛾w

(2.1)

Those factors can be modified in the Standard dialog box (see Figure 2.7, page 9), if necessary.

2.3 Cross-Sections

This windowmanages the cross-sections used for design. In addition, the module window allows
you to specify optimization parameters.

Figure 2.13: Window 1.3 Cross-Sections
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Cross-Section Description
The cross-sections defined in RFEM or RSTAB are preset, together with their material numbers.
The design is possible for the following types of cross-sections of the library:

• Parametric timber rectangular cross-sections

• Parametric timber circular cross-sections

• Standardized timber rectangular cross-sections

The new cross-section description can be entered in the text box. If the data base contains that
entry, RF-/TIMBER NBR imports the cross-section parameters.

Modified cross-sections are highlighted in blue.

If the cross-section defined in RF-/TIMBER NBR is different from the one of RFEM or RSTAB, both
sections are displayed in the graphic area. The design will then be performed with the internal
forces of RFEM/RSTAB for the section defined in RF-/TIMBER NBR.

To modify a cross-section, click the entry in column B to select the text box. Use the button or
click in the box, or press [F7] to open the dialog box of the current cross-section.

Figure 2.14: Parametric Timber Cross-Sections of the library

In the dialog box, you can select a different cross-section or a different cross-section table. To
change the cross-section category, click and access the global cross-section library.

Chapter 4.13of theRFEMmanual andChapter 4.3 of theRSTABmanual describehowcross-sections
can be selected from the library.

Max. Design Ratio
This table column is shown only after the calculation. It is useful for the optimization: By means of
the displayed design ratios and colored relation scales, you can see which cross-sections are little
utilized and thus oversized, or overloaded and thus undersized.
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Optimize
The optimization analyzes which cross-section comes as close as possible to a user-definedmax-
imum utilization ratio. You can define this maximum ratio in the Other tab of the Details dialog
box (see Figure 3.4, page 28).

If you want to optimize a cross-section, select the corresponding check box in column D or E.
Recommendations on the optimization of cross-sections can be found in Chapter 7.2 on page 50.

Note
This column shows remarks as footers. They are described below the cross-section list.

Info About Cross-Section
In the Info About Cross-Section dialog box, you can check the section properties and stress points.

Figure 2.15: Dialog box Info About Cross-Section

The buttons below the graphic of the cross-section have the following functions:

Button Function

Displays or hides the stress points

Displays or hides the numbers of stress points

Shows the details of the stress points (see Figure 2.16)

Displays or hides the dimensions of the cross-section

Displays or hides the principal axes of the cross-section

Resets the full view of the cross-section graphic

Prints the cross-section values and cross-section graphic

Table 2.3: Buttons of cross-section graphic
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To show specific information on the stress points (distances to center of gravity, statical moments
etc.), click [Details] and use the appearing dialog box.

Figure 2.16: Dialog box Stress Points

2.4 Load Duration

In this window, you define the load duration to consider factors reflecting the different load
duration for all selected load cases, load and result combinations, as well as dynamic combinations.

Figure 2.17: Window 1.4 Load Duration
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Loading
All actions selected in the 1.1 General DataWindow are listed here. For combinations, all contained
load cases are listed as well.

Description
The descriptions of the load cases help you to classify them.

Load Type
This table column shows the action type of each load case as defined in RFEM or RSTAB. They are
the basis for the default settings in the next column.

Load Duration Class
Loads and their superpositions must be assigned to the load duration classes (LDC) for the design.
The classification of actions is specified e.g. in [1] Table 1.

For load cases and result combinations, the load duration can be changed via the list shown
on the left: Click the cell in column C to select the box. The button becomes available. For
load combinations and “Or” result combinations, RF-/TIMBER NBR performs the classification
automatically, taking into account the shortest load duration class of all contained load cases.

The load duration class is required to determine the modification factor, kmod,1. This factor is also
considered for the material stiffness.

Modification Factor kmod,1
The impact of the load duration and type of timber on the strength properties is taken into account
by means of the modification factor (see [1] Table 10).

The factors can be checked in the Standard dialog box (see Figure 2.7, page 9).

Criterion
For load cases, the criterion Permanent or Variable can be changed via the list shown on the
left. This option distributes the loading on permanent and variable components for the stability
calculation according to [1] 7.5.5.

Column F is only displayed when the corresponding option in the Stability tab of theDetails dialog
box is selected (see Figure 3.2, page 26).

Combination Coefficient 𝝍1/𝝍2

If compression members are defined by slendernesses 80 < 𝜆 < 140, a buckling analysis can be
performed according to [1] 7.5.5. Those settings can be activated in the Stability tab of the Details
dialog box (see Figure 3.2, page 26). In this case, it is necessary to definie the factors 𝜓1 and 𝜓2 for
each combination in columns F and G.
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2.5 Service Conditions - Members

In this window, moisture classes are allocated to members. Besides, the first or second category
of timber is assigned. This makes it possible to modify strengths by other modification factors.

Figure 2.18: Window 1.5 Service Conditions –Members

Moisture Class
There are four moisture classes defined in [1] Table 7. The determination of the moisture class
makes it possible to assign the modification factor kmod,2. This factor is also dependent on the
type of timber as specified in [1] Table 11.

Classification of Timber
The conditions of the first and second category of timber are specified in [1] 6.4.4. According to
the classification, the modification factor kmod,3 can be determined.

Modification Factors kmod,2/kmod,3
The modification factors kmod,2 and kmod,3 are automatically determined according to the choice
in the previous columns A and B.

These factors can be checked and, if necessary, adjusted in the Standard dialog box (see Figure 2.7,
page 9).

Below the table, you find the Set input for members No. check box. If it is selected, the settings
entered afterwards will be applied to the selected or to Allmembers. Members can be selected by
entering their numbers. You can also select them graphically with the button. This option is
useful when youwant to assign the same conditions to several members. Please note that settings
that have been already defined cannot be changed subsequently with this function.
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There are three more buttons available beneath the table. They have the following functions:

Button Function

Exports the table to MS Excel

Sets the row of member which can be selected in work window of RFEM/RSTAB

Switches to work window of RFEM/RSTAB

Table 2.4: Buttons in Window 1.5 Service Conditions –Members

2.6 Service Conditions - Set of Members

This window appears if at least one set of members has been selected for the design in Window
1.1 General Data.

Figure 2.19: Window 1.6 Service Conditions - Sets of Members

The concept of this window is similar to the one of the previous Window 1.5 Service Conditions -
Members. Here you can assign the moisture and timber classes to sets of members.
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2.7 Effective Lengths - Members

The appearance of the window depends on whether the stability analysis is carried out according
to [1] 7.5 or second-order analysis. You select the method in the Stability tab of the Details dialog
box (see Figure 3.2, page 26). The following description refers to the equivalent member method.
Here, the parameters of buckling and lateral-torsional buckling have to be defined.

If the stability analysis is deactivated in the Stability tab of the Details dialog box, this window is
not shown.

Window 1.7 consists of two parts: The upper table informs you about the factors concerning
the lengths of buckling and lateral-torsional buckling of the members selected for the design.
Furthermore, the equivalent member lengths are listed. The effective lengths defined in RFEM or
RSTAB are preset. In the Settings section of this window, you can see further information on the
member whose row is selected in the upper table.

Click to select a member graphically and show its row.

You can make changes in the table as well as in the Settings tree.

Figure 2.20: Window 1.7 Effective Lengths - Members for stability analysis according to [1] 7.5

The effective lengths can be entered manually in the table and in the Settings tree, or defined
graphically in the work window after clicking . This button is enabled when you click in the box
(see Figure 2.20).

The Settings tree manages the following parameters:

• Cross-Section
• Length of member
• Buckling Possible for member (cf. column A)
• Buckling about Axis y Possible (cf. columns B to D)
• Buckling about Axis z Possible (cf. columns E to G)
• Lateral-Torsional Buckling Possible (cf. columns H to J)
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You can specify for the selected member whether a buckling or a lateral-torsional buckling design
is to be performed. Furthermore, you can adjust the Effective Length Coefficient for the respective
directions. When a coefficient ismodified, the equivalentmember length is adjusted automatically,
and vice versa.

You can also define the buckling length of a member in a dialog box. To open it, click the button
shown on the left. It is located on the right below the upper table.

Figure 2.21: Dialog box Select Effective Length Factor

For each direction, you can select one of the four EULER buckling modes or specify a User-defined
buckling length coefficient. If an eigenvalue analysis was carried out in the add-on modules
RF-STABILITY or RSBUCK, you can also select a Bucklingmode in order to determine the coefficient.

Buckling Possible
A stability analysis for flexural buckling and lateral-torsional buckling requires that members can
resist compressive forces. Therefore, members for which such resistance is not possible because
of their member types (e.g. tension members, elastic foundations, rigid couplings) are generally
excluded from the design. The corresponding rows appear dimmed and a note is displayed in the
Comment column.

The Buckling Possible check boxes in table column A and in the Settings tree offer the possibility to
control the stability analyses: They determine whether or not these analyses are carried out for a
member.

Buckling About Axis y or Axis z
With the check boxes in the Possible table columns, you decide whether a member is susceptible
to buckling about the y-axis and/or z-axis. Those axes represent the local member axes, where
the y-axis is the major and the z-axis the minor member axis. The buckling length coefficients kcr,y
and kcr,z for buckling about the major or the minor axis can be selected freely.

You can check the position of themember axes in the cross-section graphic in the 1.3Cross-Sections
Window (see Figure 2.13, page 13). To access the work window of RFEM or RSTAB, click the [View
mode] button. In the work window, you can display the local member axes via the member
shortcut menu or the Display navigator (see Figure 2.22).
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Figure 2.22: Activating the member axis systems in the Display navigator of RFEM

If buckling is possible about one or even both member axes, you can enter the buckling length
coefficients as well as the buckling lengths in columns C and D as well as F and G. The same is
possible in the Settings tree.

To specify the buckling lengths in the work window graphically, click . This button is available
when you have selected a cell of the L0 column (see Figure 2.20).

When you specify the buckling length coefficient kcr, the program determines the effective length
L0 by multiplying the member length L by the buckling length coefficient. The text boxes of kcr
and L0 are interactive.

Lateral-Torsional Buckling Possible
Table column H shows you for which members the program performs an analysis of lateral-tor-
sional buckling.

L1 Manually

The equivalent member length relevant for the lateral-torsional buckling is preset by the member
length. Having selected the check box in column I, you can specify the length for lateral-torsional
buckling L1 in column J. You can also define it graphically after clicking as the distance of the
lateral supports. It can be useful to adjust a structural component if it consists of several members
between the supports.

Below the Settings table, you find the Set input for members No. check box. If it is selected, the
settings entered afterwards will be applied to the selected or to Allmembers. Members can be
selected by entering their numbers. You can also select them graphically with the button.
This option is useful when you want to assign the same boundary conditions to several members.
Please note that settings that have already been defined cannot be changed subsequently with
this function.

Comment
In the last table column, you can enter you own comments to describe, for example, the effective
lengths of specific members.
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2.8 Effective Lengths - Sets of Members

This window appears only if at least one set of members has been selected for the design in
Window 1.1 General Data and the stability check has been activated in the Stability tab of the
Details dialog box (see Figure 3.2, page 26).

Figure 2.23: Window 1.8 Effective Lengths - Sets of Members

The concept of this window is similar to the one of the previous window 1.7 Effective Lengths -Mem-
bers. Here you can enter the effective lengths for buckling as well as for lateral-torsional buckling
of the set of members as described in Chapter 2.7. They determine the boundary conditions of
the entire set of members that is treated as an equivalent member.
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2.9 Serviceability Data

The last input window controls the settings for the serviceability limit state design of specific
objects. It is available when one or more load cases or combinations have been selected in the
Serviceability Limit State tab of Window 1.1 (see Chapter 2.1.2, page 8).

Figure 2.24: Window 1.9 Serviceability Data

In column A, you define whether the deformation refers to single members, lists of members, or
sets of members.

For a list or set of members, the orientation and rotation of all contained members must be
identical. This will guarantee that the components of the deformation are taken into account
correctly.

In column B, you can specify the numbers of the members or sets of members that are to be
analyzed. The button enables you to select the objects graphically in the work window. In
column D, the Reference Length of each object is shown. The geometrical lengths of the members,
lists or sets of members are set by default. If necessary, you can adjust those values after having
selected theManually check box in column C.

Column E controls the governing Direction for the deformation analysis. You can select the direc-
tions of the local member axes y and z or the resultant R.

Columns F and G enable you to consider a Precamberwc,y andwc,z for the design.

The Beam Type is important for the correct reference to the limit deformations. In column G, you
can specify a beam or a cantilever is to be analyzed. For the latter, you can define which end has
no support.

The settings in the Serviceability tab of the Details dialog box control whether the deformations
refer to the undeformed original model or to the shifted ends of members or sets of members (see
Figure 3.3, page 27).
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3 Calculation

3.1 Detail Settings

Before you start the calculation, it is recommended to check the design details. You can open the
corresponding dialog box in all windows of the add-on module by clicking [Details].

The Details dialog box contains the following tabs:

• Resistance
• Stability
• Serviceability
• Other

3.1.1 Resistance

Figure 3.1: Dialog box Details, tab Resistance

Consideration of Connections
The connection of members often weakens the cross-section in the zone of the joint. This effect
can be accounted for by a Reduction of limit tension stresses. The numbers of the relevant nodes
can be entered manually or selected graphically via the button.

The Connection length defines the zone on the member where reduced stresses are to be applied.
In the text box below, the maximum Stress ratio inside connections can be entered as percentage.
If required, the Stress ratio outside connections can be modified as well.
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3.1.2 Stability

Figure 3.2: Dialog box Details, tab Stability

Stability Analysis
The Perform stability analysis check box controls whether a stability analysis is performed along
with the cross-section design. If you clear the selection of the check box, Window 1.5 and 1.6 will
not be shown.

Method of analysis
in RFEM/RSTAB

The Stability analysis according to [1] 7.5 uses the internal forces determined by RFEMor RSTAB. For
this method, make sure that theGeometrically linear static analysis has been set (the default for
load combinations is second-order analysis). To perform the stability analysis according to [1] 7.5,
the effective lengths of themembers and sets of members subject to compression or compression
and bending must be specified in Window 1.7 and 1.8.

If the bearing capacity of a structural system is significantly affected by its deformations, it is
recommended to apply the Stress/staility analysis according to second order theory. This approach
requires the definition of imperfections in RFEM/RSTAB and their consideration for the relevant
load combinations. The flexural buckling analysis is carried out during the calculation of the load
combinations in RFEM or RSTAB.

For the second order calculation, the lateral-torsional buckling design must be carried out nev-
ertheless. Thus, the lengths for lateral-torsional buckling of members or sets of members must
be specified in Window 1.7 or 1.8 manually. In this way, it is guaranteed that the lateral-torsional
buckling analysis is performed with the appropriate factors (e.g. 1.0).
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Buckling of Slender CompressionMembers
If the first check box is selected, a buckling analysis is performed formembers defined by slender-
ness 80 < 𝜆 < 140 according to [1] 7.5.5. This option requires additional settings concerning
the combination coefficients for loading which can be defined in Window 1.4 (see Chapter 2.4,
page 16).

When the first check box is selected, it is possible to Distribute loading on permanent and variable
components. Those settings are managed by Window 1.4 as well. If the first check box is not
activated, this option is not available. Members with 𝜆 > 80will then be verified as unsatisfactory.

3.1.3 Serviceability

Figure 3.3: Dialog box Details, tab Serviceability

The two options control whether the deformation is to be relative to the Shiftedmember ends (or
ends of sets of members), i.e. the connection line between start and end nodes of the deformed
system. Alternatively, the deformation can be referred to the Undeformed system. In most cases,
the deformations can be checked relative to the displacements of the entire model.

You can find an example how to refer the deformations of members in the following article:
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/001081.

The limit deformations can be checked and, if necessary, adjusted in the Standard dialog box (see
Figure 2.7, page 9).
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3.1.4 Other

Figure 3.4: Dialog box Details, tab Other

Cross-Section Optimization
The optimization is targeted on the maximum design ratio of 100 %. If necessary, you can specify
a different limit value in this text box.

Check of Member Slendernesses
The two text boxes in this section define the limit values 𝜆limit which control the member slender-
nesses. It is possible to enter specifications separately for members with pure tension forces and
for members with bending and compression.

The limit values are compared to the real member slendernesses in Window 3.3. This window is
available after the calculation (see Chapter 4.8, page 36) if the corresponding check box is selected
in the Display Result Windows section (see below).

Display Result Windows
In this dialog section, you can select the resultswindows including parts lists that you want to
display in the output. Those windows are described in Chapter 4.

Window 3.3 Member Slendernesses is deactivated by default.
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3.2 Start Calculation

To start the [Calculation], click the corresponding button which is available in all input windows
of RF-/TIMBER NBR.

The add-on module searches for the results of the load cases, load combinations, and result
combinations to be designed. If those are not available yet, RF-/TIMBER NBR starts the calculation
in RFEM or RSTAB to determine the relevant internal forces.

The calculation an also be started in the user interface of RFEM or RSTAB: The To Calculate dialog
box (menu Calculate → To Calculate) includes the design cases of all add-on modules, too.

Figure 3.5: Dialog box To Calculate of RFEM

If the RF-/TIMBER NBR cases are missing in the Not Calculated section, select All or Add-onModules
in the drop-down list below.

To transfer the selected RF-/TIMBER NBR cases to the list on the right, use the button . Click
[OK] to start the calculation.

To calculate a design case directly, use the list in the toolbar. Select the RF-/TIMBER NBR case in
the toolbar list, and then click [Show Results].

Figure 3.6: Direct calculation of a RF-TIMBER NBR design case in RFEM

Subsequently, you can observe the design in a separate dialog box.
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4 Results
Window 2.1 Design by Load Case is displayed immediately after the calculation.

Figure 4.1: Result window with design results and details

The design results are shown in the result Windows 2.1 through 2.5, sorted by different criteria.

Windows 3.1 and 3.2 list the governing internal forces. Window 3.3 informs you about themember
slendernesses. The last two result Windows 4.1 and 4.2 show the parts lists sorted by member and
set of members.

Every window can be selected by clicking the corresponding entry in the navigator. To set the
previous or next input window, use the buttons shown on the left. You can also use the function
keys to select the next [F2] or previous [F3] window.

To save the results, click [OK]. You exit RF-/TIMBER NBR and return to the main program.

Chapter 4 describes the different result windows one by one. The evaluation and checking of the
results is described in Chapter 5 starting on page 40.
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4.1 Design by Load Case

The upper table provides a summary of the results, sorted by load cases, load and result combina-
tions of the governing designs. Furthermore, the list is split into Ultimate Limit State Design and
Serviceability Limit State Design results.

The Details section below contains detailed information on the cross-section properties, design
internal forces, and design details of the load case or combination selected in the upper table.

Figure 4.2: Window 2.1 Design by Load Case

Description
This column shows the descriptions of each designed load case, load or result combination.

Member No.
In this column, the number of each member is given that has the maximum design ratio of the
respective loading.

Location x
The column shows the x-location of the member at which the maximum ratio occurs. For the
tabular output, the program uses the following member locations x:

• Start and end nodes

• Division points according to optionally defined member division (see RFEM Table 1.16 or
RSTAB Table 1.6)

• Member division according to specification for member results (see RFEM/RSTAB dialog box
Calculation parameters, tab Global Calculation Parameters)

• Extreme values of internal forces
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Design
Columns D and E show the design conditions according to NBR 7190:1997 [1].

The lengths of the colored scales graphically represent the respective design ratios.

Design According to Formula
This column lists the references in [1] according to which the different types of design have been
performed.

Load Duration
Column H shows the load duration classes as defined in Window 1.4 (see Chapter 2.4, page 16).

4.2 Design by Cross-Section

Figure 4.3: Window 2.2 Design by Cross-Section

This window lists the maximum ratios of all members and loadings selected for design, sorted by
cross-section. For each section, the results are given for cross-section design, stability analysis,
and serviceability limit state design.
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4.3 Design by Set of Members

Figure 4.4: Window 2.3 Design by Set of Members

This result window is displayed when you have selected at least one set of members for the design.
It lists the maximum design ratios sorted by set of members.

TheMember No. column shows the number of themember within the set which has themaximum
ratio with respect to the specific design criterion.

The output by set of members clearly presents the design for structural groups, e.g. chords.



4 Results

©DLUBAL SOFTWARE 2017

34

4

4.4 Design byMember

Figure 4.5: Window 2.4 Design byMember

This result window presents the maximum ratios of the individual designs for each member. The
columns are described in Chapter 4.1 on page 31.

4.5 Design by x-Location

Figure 4.6: Window 2.5 Design by x-Location
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This result window lists the maxima for each member at all locations x resulting from the division
points in RFEM or RSTAB:

• Start and end nodes

• Division points according to optionally defined member division (see RFEM Table 1.16 or
RSTAB Table 1.6)

• Member division according to specification for member results (see RFEM/RSTAB dialog box
Calculation Parameters, tab Global Calculation Parameters)

• Extreme values of internal forces

4.6 Governing Internal Forces byMember

Figure 4.7: Window 3.1 Governing Internal Forces byMember

For all designed members, this window displays the governing internal forces, i.e. those internal
forces that produce the maximum ratio of each design.

Location x
At this x-location of the member, the respective maximum design ratio occurs.

Load Case
This column displays the numbers of the load case, load or result combination whose internal
forces result in the maximum design ratios.

Forces / Moments
For each member, these columns present the axial and shear forces as well as the torsional and
bendingmoments which give themaximum ratios in the respective cross-section designs, stability
analyses, and serviceability limit state designs.
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Design According to Formula
The final column informs you about the design types and equations by which the designs have
been performed according to the Standard [1].

4.7 Governing Internal Forces by Set of Members

Figure 4.8: Window 3.2 Governing Internal Forces by Set of Members

This window contains the individual internal forces that result in the maximum ratios of the
respective design for each set of members.

4.8 Member Slendernesses

Window 3.3 is shown when you have selected the respective check box in the Other tab of the
Details dialog box (see Figure 3.4, page 28).
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Figure 4.9: Window 3.3 Member Slendernesses

The table lists the effective slenderness ratios of the designed members for both directions of the
principal axes. They depend on the load type.

Below the list, you find a comparison of the most unfavorable values with the limit values. The
latter are managed in the Other tab of the Details dialog box (see Figure 3.4, page 28).

Members of the member type “Tension” or “Cable” are not included in this table.

This window is displayed only informative. It does not provide any stability analysis of slender-
nesses.
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4.9 Parts List byMember

Finally, RF-/TIMBER NBR provides a summary of all cross-sections contained in the design case.

Figure 4.10: Window 4.1 Parts List byMember

By default, this list contains only designed members. If you need a parts list of all members of
the model, select the corresponding option in the Details dialog box, tab Other (see Figure 3.4,
page 28).

Part No.
The program automatically assigns item numbers to similar members.

Cross-Section Description
This column lists the cross-section numbers and descriptions.

Number of Members
Column B shows howmany similar members are used for each part.

Length
This column displays the respective length of an individual member.

Total Length
In this column, the product determined from the two previous columns is given.

Surface Area
For each part, the program specifies the surface area relative to the total length. This area is
determined from the Surface Area of the cross-sections. It can be checked in Window 1.3 and
Windows 2.1 to 2.5 (see Figure 2.15, page 15).
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Volume
The volume of a part is determined from the cross-sectional area and the total length.

Unit Weight
The unit mass of the cross-section is related to the length of one meter.

Weight
The values of this column represent the products of the entries in columns C and G.

Total Weight
The final column gives the total mass of each part.

Sum
At the end of the list, you find a sum of the values in columns B, D, E, F, and I. The last row of the
column Total Weight gives information about the total amount of timber required.

4.10 Parts List by Set of Members

Figure 4.11: Window 4.2 Parts List by Set of Members

The last result window is displayed when you have selected at least one set of members for design.
It represent the parts list of structural groups, e.g. chords.

Details on the various columns can be found in Chapter 4.9. If there are different cross-sections
in the set of members, the program averages the surface area, the volume, and the cross-section
weight.
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5 Results Evaluation
You can evaluate the design results in different ways. The buttons below the upper table are very
useful for that.

Figure 5.1: Buttons for results evaluation

Button Description Function

Ultimate Limit
State Design

Shows or hides the results of the ULS design

Serviceability Limit
State Designs

Shows or hides the results of the SLS design

Color Bars Shows or hides the colored relation scales in the tables

Filter Parameters
Describes the filter criterion for the output in the tables:
Design ratios greater than 1, maximum value or user-defined
limit

Apply Filter
Displays only rows where the filter parameters are valid
(ratio > 1, maximum, user-defined value)

Result Diagrams
Opens the Result Diagram onMemberWindow
→ Chapter 5.2, page 43

Excel Export
Exports the table to MS Excel
→ Chapter 7.4.3, page 53

Member Selection
Allows you to graphically select a member in the work
window to display its results in the table

View Mode
Jumps to the work window of RFEM or RSTAB to check or
change the view

Table 5.1: Buttons in result Windows 2.1 through 2.5
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5.1 Results in RFEM/RSTABModel

You can also evaluate the design results in the work window of RFEM or RSTAB.

Background graphic and viewmode
The work window of RFEM or RSTAB in the background is useful for you to find the position of a
particularmember in themodel: There, themember selected in the RF-/TIMBERNBR result window
is highlighted. Furthermore, an arrow indicates the relevant location x of this member.

Figure 5.2: Indication of member and relevant Location x in RFEMmodel

If you cannot improve the display by moving the RF-/TIMBER NBR module window, click the
button to activate the viewmode. Thus, you hide the module window so that you can change the
view in the user interface of RFEM or RSTAB. In the viewmode, you can use the functions of the
Viewmenu, e.g. zoom, move, or rotate the view. The pointer remains visible.

Click [Back] to return to the RF-/TIMBER NBR module.

RFEM/RSTABwork window
You can also check the design ratios graphically in the RFEM/RSTABmodel: Click [Graphics] to quit
the design module. In the work window of RFEM or RSTAB, the design ratios are now displayed
like the internal forces of a load case.

To turn the display of the design ratios on or off, use the [Show Results] button which is familiar
from the display of internal forces. To switch the result values on or off, click the [Show Values]
button next to it.

The tables of RFEM or RSTAB are of no relevance for the timber design results.

The design cases can be selected in the list of the menu bar.
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The graphical representation of the design results can be controlled in the Display navigator, item
Results → Members. The ratios are shown Two-Colored by default.

Figure 5.3: Display navigator – Results → Members

When you have selected a multicolor display (optionsWith/Without Diagram or Cross-Sections),
the color panel is available. It provides the usual control functions. They are described in detail in
the RFEM/RSTAB manual, Chapter 3.4.6.

Figure 5.4: Design ratios with display optionWithout Diagram

The graphics of the design results can be transferred to the printout report (see Chapter 6.2,
page 46).

To return to the add-on module, use the [RF-/TIMBER NBR] button in the panel.



5 Results Evaluation

©DLUBAL SOFTWARE 2017

43

5

5.2 Result Diagram

You can graphically evaluate the design ratios of members or sets of members in a result diagram,
without using the work window of RFEM or RSTAB.

Select the member (or set of members) in the RF-/TIMBER NBR result window by clicking in the
relevant table row. Then click the button to open the Result Diagram onMember dialog box.
This button is located below the upper table (see Figure 5.1, page 40).

In the work window of RFEM or RSTAB, the result diagram can be accessed from the menu

Results → Result Diagrams for SelectedMembers

or via the toolbar button shown on the left.

A new window opens. It presents the distribution of the maximum design values on the member
or set of members.

Figure 5.5: Dialog box Result Diagram onMember

You can switch the ULS and SLS results on or off in the Results navigator.

Use the list in the toolbar to select the relevant RF-/TIMBER NBR design case.

The Result Diagram onMember dialog box is described in the RFEM or RSTAB manual, Chapter 9.5.
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5.3 Filter for Results

The RF-/TIMBER NBR result windows allow you to sort the results by various criteria. In addition,
you can use the filter options for the tables (see Figure 5.1, page 40) to reduce the numerical
output according to specific ratios. This function is described in the Knowledge Base at our Web
site:
https://www.dlubal.com/en/support-and-learning/support/knowledge-base/000733

Furthermore, you can apply the filter options described in Chapter 9.9 of the RFEM manual or
Chapter 9.7 of the RSTAB manual to evaluate the results graphically.

You can also use the Visibility options for RF-/TIMBER NBR to filter themembers and evaluate them
(see RFEMmanual, Chapter 9.9.1 or RSTAB manual, Chapter 9.7.1).

Filtering design ratios
The design ratios can be used as filter criteria in the RFEM/RSTAB work window which you access
by clicking [Graphics]. To apply this filter function, the panel must be displayed. If it is not, select.

View → Control Panel (Color scale, Factors, Filter)

or use the toolbar button shown on the left.

The panel is described in the RFEM/RSTAB manual, Chapter 3.4.6. The filter settings for the results
can be defined in the first tab (Color scale). As this tab is not available for the two-colored results,
you haveset the display option Colored With/Without Diagram or Cross-Sections in the Display
navigator (see Figure 5.3, page 42).

Figure 5.6: Filtering design ratios with adjusted color spectrum

As seen in Figure 5.6, the color spectrum can be set in such a way that only ratios greater than
0.50 are shown in the color ranges between blue and red.
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Filteringmembers
In the Filter tab of the control panel, you can specify the numbers of particular members to display
their results exclusively, i.e. filtered. This function is described in the RFEMmanual, Chapter 9.9.3
or RSTAB manual, Chapter 9.7.3.

Figure 5.7: Member filter for ratios of diagonals

Unlike the Visibility function, the entire model is displayed. Figure 5.7 shows the ratios of the truss
diagonals. All other members are displayed in the model, but they have no design ratios.
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6 Printout

6.1 Printout Report

Similarly to RFEM or RSTAB, the program generates a printout report for the RF-/TIMBER NBR
results which can be supplemented by graphics and descriptions. The selection in the printout
report determines what data from the design module are to be included in the final printout.

The printout report is described in the RFEM or RSTAB manual. In particular, Chapter 10.1.3.5
Selecting Data of Add-on Modules describes how the input and output data of add-on modules
can be selected.

For complex models with many design cases, it is recommended to split the data into several
printout reports, thus allowing for a clearly-arranged documentation.

6.2 Graphic Printout

In RFEM or RSTAB, you can add any picture of the work window to the printout report or send it
directly to a printer. In this way, the design ratios shown on the RFEM/RSTAB model can be used
for the documentation.

The printing of graphics is described in the RFEM or RSTAB manual, Chapter 10.2.

Design ratios in RFEM/RSTABmodel
To print the currently displayed design ratios, click

File → Print Graphic

or use the toolbar button shown on the left.

Figure 6.1: [Print Graphic] button in RFEM toolbar

Result diagrams
You can also transfer the Result Diagram onMember images to the printout report or print them
directly by using the [Print] button.

Figure 6.2: [Print] button in Result Diagram onMember dialog box

The Graphic Printout dialog box appears (see Figure 6.3).
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Figure 6.3: Dialog box Graphic Printout, tab General

This dialogbox is described in theRFEMorRSTABmanual, Chapter 10.2. That chapter alsodescribes
the other tabs of the dialog box.

You canmove a graphic anywhere within the printout report by using the drag-and-drop function.

If youwant tomodify an image in the printout report, right-click the relevant entry in the navigator
of the printout report. The Properties option in the shortcut menu opens the Graphic Printout
dialog box again. It offers you several options to adjust the image.

Figure 6.4: Dialog box Graphic Printout, tab Options
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7 General Functions
This chapter describes useful menu functions and export options for the design results.

7.1 Design Cases

Design cases allow you to arrange members for specific analyses. In this way, you can combine
groups of structural components or analyze members with particular design specifications, e.g.
modified materials, partial safety factors, cross-sections.

It is no problem to analyze the same member or set of members in different design cases.

To calculate a RF-/TIMBER NBR design case, you can also use the load case list in the toolbar of
RFEM or RSTAB.

Create design case
To create a new design case, use the RF-/TIMBER NBR menu and select

File → New Case.

The following dialog box appears.

Figure 7.1: Dialog box New RF-TIMBER NBR-Case

Enter a No. (one that is still available) for the new design case and an optional Description. It
facilitates the selection in the load case list.

Then click [OK] to open the 1.1 General DataWindow of RF-/TIMBER NBR where you can enter the
new design data.

Rename design case
To change the description of a design case, use the RF-/TIMBER NBR menu and select

File → Rename Case.

The following dialog box appears.

Figure 7.2: Dialog box Rename RF-TIMBER NBR-Case

You can specify a different Description as well as a different No. for the design case.
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Copy design case
To copy the input data of the current design case, use the RF-/TIMBER NBR menu and select

File → Copy Case.

The following dialog box appears.

Figure 7.3: Dialog box Copy RF-TIMBER NBR-Case

Define the No. and, if necessary, a Description of the new case.

Delete design case
To delete a design case, use the RF-/TIMBER NBR menu and select

File → Delete Case.

The following dialog box appears.

Figure 7.4: Dialog box Delete Cases

Select the design case in the list of Available Cases. To delete this case, click [OK].
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7.2 Cross-Section Optimization

The design module offers you the option to optimize overstressed or little utilized cross-sections.
To do this, select Yes for the relevant cross-section(s) in Window 1.3 Cross-Sections, column C resp.
D (see Figure 2.13, page 13).

You can also start the optimization in the result windows via the shortcut menu.

Figure 7.5: Shortcut menu for cross-section optimization

During the optimization, the module determines the cross-section that fulfills the analysis require-
ments in the “optimal” way, i.e. comes as close as possible to the maximum allowable design ratio
specified in the Details dialog box (see Figure 3.4, page 28). The required cross-section properties
are calculated with the internal forces of RFEM or RSTAB. If a different cross-section proves to be
more favorable, it will be used for the design. In this case, the graphic in Window 1.3 shows two
cross-sections – the original section from RFEM or RSTAB and the optimized one (see Figure 7.7).

For a parametric cross-section, the following dialog box appears when you have selected Yes from
the drop-down list.

Figure 7.6: Dialog box Timber Cross-Sections - Rectangle : Optimize
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By selecting the check boxes in the Optimize column, you decide which parameter(s) you want to
modify. This enables theMinimum andMaximum columns where you can specify the upper and
lower limits of the parameter. The Increment column determines the interval in which the size of
the parameter varies during the optimization.

If you want to Keep current side proportions, select the corresponding check box. In addition, you
have to select two parameters for the optimization.

Please note that the internal forces are not automatically recalculated with the modified cross-sec-
tions during the optimization: It is up to you to decide which sections should be transferred to
RFEM or RSTAB for a new calculation. As a result of optimized cross-sections, the internal forces
may vary considerably because of the changed stiffnesses of the model. Therefore, it is recom-
mended to recalculate the internal forces of themodified cross-sections after the first optimization,
and then to optimize the sections once again.

To export the modified cross-section(s) to RFEM or RSTAB, go to Window 1.3 Cross-Sections and
select

Edit → Export All Cross-Sections to RFEM/RSTAB.

The shortcut menu of Window 1.3 also provides some options to export optimized cross-sections
to RFEM or RSTAB.

Figure 7.7: Shortcut menu in Window 1.3 Cross-Sections

Before themodified cross-sections are transferred to RFEMor RSTAB, a query appears as towhether
the RFEM/RSTAB results should be deleted.

Figure 7.8: Query when exporting cross-sections
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By confirming the query and then starting the [Calculation] in the RF-/TIMBER NBRmodule, the
internal forces of RFEM or RSTAB as well as the design ratios will be determined in one single
calculation run.

If the modified cross-sections have not been exported to RFEM or RSTAB yet, you can reimport the
original sections in the design module by using the last two options shown in Figure 7.7. Please
note that this shortcut menu is only available in Window 1.3 Cross-Sections.

7.3 Units and Decimal Places

The units and decimal places of RFEM or RSTAB and of all add-on modules are managed in one
dialog box. To define the units for RF-/TIMBER NBR, select the menu

Settings → Units and Decimal Places.

The dialog box which is familiar from RFEM or RSTAB appears. RF-/TIMBER NBR is preset in the
Program /Module list.

Figure 7.9: Dialog box Units and Decimal Places

You can save the settings as a user-defined profile to reuse them in other models. Those functions
are described in the RFEM or RSTAB manual, Chapter 11.1.3.
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7.4 Data Transfer

7.4.1 ExportingMaterials to RFEM/RSTAB

If youhavemodified thematerials in RF-/TIMBERNBR for the design, you can export thosematerials
to RFEM or RSTAB in a similar way as you export cross-sections: Open the 1.2 MaterialsWindow
and then select

Edit → Export All Materials to RFEM/RSTAB.

You can also export the modified materials to RFEM or RSTAB by using the shortcut menu of
Window 1.2.

Figure 7.10: Shortcut menu of Window 1.2 Materials

Before the modified materials are transferred to RFEM or RSTAB, a query appears as to whether
the results of the main program should be deleted. When you have confirmed the query and
then start the [Calculation] in RF-/TIMBER NBR, the new internal forces and the design ratios are
determined in one single calculation run.

If the modified materials have not been exported to RFEM or RSTAB yet, you can transfer the
original materials to the design module with the last two options shown in Figure 7.10. Please
note that this shortcut menu is only available in Window 1.2 Materials.

7.4.2 Exporting Effective Lengths to RFEM/RSTAB

If you have adjusted the effective lengths in RF-/TIMBER NBR for the design, you can export
the modified values to RFEM or RSTAB in a similar way as you export cross-sections: Got to the
1.7 Effective Lengths - MembersWindow and then select

Edit → Export All Effective Lengths to RFEM/RSTAB.

You can also use the corresponding option on the shortcut menu of Window 1.7.

Figure 7.11: Shortcut menu of Window 1.7 Effective Lengths - Members

Before the modified effective lengths are transferred to RFEM or RSTAB, a query appears as to
whether the results of the main program should be deleted.

7.4.3 Exporting Results

The RF-/TIMBER NBR results can also be used by other programs.

Clipboard
To copy selected cells of the result windows to the Clipboard, use the keys [Ctrl]+[C]. Press [Ctrl]+[V]
to insert the cells, for example in a word processing program. The headers of the table columns
will not be transferred.
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Printout Report
You can print the data of RF-/TIMBER NBR into the global printout report (see Chapter 6.1, page 46).
To export the tables and graphics, then select the printout report menu

File → Export to RTF.

This function is described in the RFEM or RSTAB manual, Chapter 10.1.11.

Excel
RF-/TIMBER NBR provides a function for the direct data export to MS Excel or the CSV file format.
To open the corresponding dialog box, select the menu

File → Export Tables.

Figure 7.12: Dialog box Export of Tables

When you have selected the relevant options, you can start the export by clicking [OK]. Excel will
be started automatically, i.e. you do not have to open the program before.

Figure 7.13: Results in Excel
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8 Example: Timber Beam
A timber beam with rectangular cross-section is designed according to NBR 7190:1997 [1]. The
beam is restrained and subjected to compression and bending.

8.1 System and Loads

Figure 8.1: System and loads according to [2]

Model
Cross-section: b/d = 6/12 cm
Material: Hardwood C40

Moisture Class: 1

Category of Timber: Second

Loads and Combinations
LC1: N = 15 kN

MA = 33.4 kN/cm
MB = 2.2 kN/cm
LDC permanent

LC2: N = 10 kN

MA = 22.3 kN/cm
MB = 1.4 kN/cm
LDC long-term

CO1 (ULS): 1.4 LC1 + 1.4 LC2

CO2 (SLS): 1.0 LC1 + 0.2 LC2
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8.2 Calculation with RFEM/RSTAB

The system as well as the loads in all load cases is modeled in RFEM/RSTAB as a 3D model. We
deactivate the automatic consideration of the self-weight when we create LC1.

We create load combination CO1 with the respective factors from the defined load cases. Then
we calculate the model according to the linear static analysis.

For the SLS combination CO2, it is necessary to consider the Effective Modulus of Elasticity, Ec0,ef.
This value can be calculated according to the formula in [1] 6.4.9 as follows:

kmod = kmod ,1 ⋅ kmod ,2 ⋅ kmod ,3

kmod = 0.7 ⋅ 1.0 ⋅ 0.8 = 0.56

Ec0,ef = kmod ⋅ Ec0,m = 0.56 ⋅ 1,950 = 1,092 MPa

We define the factor kmod = 0.56 in the Edit Load Cases and Combinations dialog box, Modify
Stiffness tab. It can be assigned individually to each material. As there is only one material in our
example, however, we can modify the stiffness globally.

Figure 8.2: Modifying Modulus of Elasticity in the Edit Load Cases and Combinations dialog box

There would be even more options to modify the stiffness in the Edit Load Cases and Combinations
dialog box: For example, we could allocate specific stiffness factors to members and consider the
modified stiffness in the Edit Member dialog box separately for each member.

RFEM/RSTAB determines the diagrams of internal forces and deformation as seen in Figure 8.3.

Figure 8.3: Internal forces N,My, Vz, and deformation uz
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8.3 Design with RF-/TIMBER NBR

8.3.1 Ultimate Limit State Design

In the 1.1 General Datawindow, we select CO1 for the Ultimate Limit State design.

Figure 8.4: Window 1.1 General Data

The next windows contain information on the selected material and cross-section.

Figure 8.5: Window 1.2 Materials
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Figure 8.6: Window 1.3 Cross-Sections

In Window 1.4 Load Duration, factor kmod ,1 of CO1 is determined according to the shortest load
duration within the combination. As the stability analysis for members defined by slenderness
80 < 𝜆 ≤ 140 is performed according to [1] 7.5.5, it is also necessary to define the coefficients 𝜓1

and 𝜓2. The criterion ‘Permanent' or ‘Variable' for the stability analysis is applied according to the
LDC settings.

Figure 8.7: Window 1.4 Load Duration
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In Window 1.5 Service Conditions - Members, we specify the moisture class and the timber category.
They determine the modification factors kmod ,2 and kmod ,3.

Figure 8.8: Window 1.5 Service Conditions - Members

InWindow 1.7 Effective Lengths -Members, we define the buckling lengths of the beam. The default
buckling length coefficients kcr,y = kcr,z = 1.0 are adequate for our example. Likewise, the
effective length for lateral-torsional buckling is equal to the member length, L1 = 169 cm.

Figure 8.9: Window 1.7 Effective Lengths - Members

Then we can start the [Calculation].
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Results

After the calculation, Window 2.1 Design by Load Case presents the governing designs.

Figure 8.10: Window 2.1 Design by Load Case

The Details in the lower section correspond to the designs in [1].

Design Strengths
Design compressive strength

fc0,d = kmod ,1 ⋅ kmod ,2 ⋅ kmod ,3 ⋅
fc0,k

𝛾wc

fc0,d = 0.70 ⋅ 1.00 ⋅ 0.80 ⋅ 4.00
1.40

fc0,d = 1.60 kN/m2

Design tensile strength

ft0,d = kmod ,1 ⋅ kmod ,2 ⋅ kmod ,3 ⋅
ft0,k

𝛾wt

ft0,d = 0.70 ⋅ 1.00 ⋅ 0.80 ⋅ 5.20
1.80

ft0,d = 1.62 kN/m2

Design shear strength

fv0,d = kmod ,1 ⋅ kmod ,2 ⋅ kmod ,3 ⋅
fv0,k

𝛾wv

fv0,d = 0.70 ⋅ 1.00 ⋅ 0.80 ⋅ 0.60
1.80

fv0,d = 0.19 kN/m2
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Effective modulus of elasticity

Ec0,ef = kmod ,1 ⋅ kmod ,2 ⋅ kmod ,3 ⋅ Ec0,m

Ec0,ef = 0.70 ⋅ 1.00 ⋅ 0.80 ⋅ 1,950

Ec0,ef = 1,092 kN/m2

Stress Analysis
Compressive stress

𝜎Nc,d
=

Nc,d

A
= 35 kN

72 cm2
= 0.49 kN/cm2

Bending stress

𝜎My,c,d = 𝜎My,t,d =
My,d

Sy
= 77.98 kNcm

144 cm3
= 0.54 kN/cm2

Shear stress

𝜏Vz,d =
Vz,d ⋅ Qy

Iy ⋅ b
= 0.432 kN ⋅ 108 cm3

864 cm4 ⋅ 6 cm
= 0.01 kN/cm2

Buckling Design
The verification of buckling requires the calculation of additional moments due to eccentricities,
as specified in [1] 7.5.

Axis y

𝜆y =
L0,y

iy
= 169 cm

3.464 cm
= 48.79

As the slenderness is 40 < 𝜆 ≤ 80, the buckling design about the y-axis follows [1] 7.5.4.

Critical force

FE,y =
𝜋2 ⋅ Ec0,ef ⋅ Iy

L20,y
= 𝜋2 ⋅ 1,092 kN/m2 ⋅ 864 cm4

(169 cm)2
= 326.03 kN

Eccentricity (minimum accidental)

ea =
L0,y

300
= 169 cm

300
= 0.563 cm

Eccentricity (initial)

ei = max(
M1,y,d

Nc,d
; ℎ
30

) = max(77.98 kNcm
35.00 kN

; 12 cm
30

) = 2.228 cm

Eccentricity (first order)

e1 = ea + ei = 0.563 cm + 2.228 cm = 2.791 cm

Eccentricity (design)

ed = e1 ⋅ (
FE,y

FE,y − Nc,d
) = 2.791 cm ⋅ ( 326.03 kN

326.03 kN − 35.00 kN
) = 3.127 cm

Bending moment from eccentricities

Md = Nc,d ⋅ ed = 35.00 kN ⋅ 3.127 cm = 109.44 kNcm

Design stress for compression due to bending moment from eccentricities

𝜎Md
= Md

Sy
= 109.44 kNcm

144 cm3
= 0.76 kN/cm2
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Axis z

𝜆z =
L0,z

iz
= 169 cm

1.732 cm
= 97.572

As the slenderness is 80 < 𝜆 ≤ 140, the buckling design about the z-axis follows [1] 7.5.5.

Critical Force

FE,z =
𝜋2 ⋅ Ec0,ef ⋅ Iz

L20,z
= 𝜋2 ⋅ 1,092 kN/m2 ⋅ 216 cm4

(169 cm)2
= 81.51 kN

Eccentricity (minimum accidental)

ea = max(
L0,z

300
; b
30

) = max(169 cm
300

; 6 cm
30

) = 0.563 cm

Eccentricity, permanent loads (first order)

eig =
M1g,z,d

Ng,c,d
= 0 kNcm

21.00 kN
= 0

Eccentricity (initial)

ei =
M1,z,d

Nc,d
= 0 kNcm

35.00 kN
= 0

Eccentricity (creep)

ec = (ea + ei) ⋅ {exp[
𝜙 ⋅ [Ng,c,k + (𝜓1 + 𝜓2) ⋅ Nq,c,k]

FE,z − [Ng,c,k + (𝜓1 + 𝜓2) ⋅ Nq,c,k]
] − 1}

ec = (0 + 0.563) ⋅ {exp [ 0.8 ⋅ [15.00 + (0.3 + 0.2) ⋅ 10.00]
81.51 − [15.00 + (0.3 + 0.2) ⋅ 10.00]

] − 1} = 0.1674 cm

Eccentricity (first order, effective)

e1,ef = ei + ea + ec = 0 + 0.563 cm + 0.1674 cm = 0.7307 cm

Bending moment from eccentricities

Md = Nc,d⋅e1,ef (
FE,z

FE,z − Nc,d
) = 35.00kN⋅0.7307cm( 81.51 kN

81.51 kN − 35.00 kN
) = 44.82kNcm

Design stress for compression due to bending moment from eccentricities

𝜎Md
= Md

Sz
= 44.82 kNcm

72 cm3
= 0.62 kN/cm2
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Combined Bending and Axial Compression Design
The bending stresses are determined separately for the tension and compression zones according
to [1] 7.3.6.

Design 1 – tension zone

− (
𝜎Nc,d

fc0,d
)

2

+
𝜎My,t,d

ft0,d
+ kM ⋅

𝜎Mz,t,d

ft0,d
≤ 1.00

− (0.49
1.60

)
2

+ 0.54
1.62

+ 0.5 ⋅ 0
1.62

= 0.24 ≤ 1.00

Design 2 – compression zone

(
𝜎Nc,d

fc0,d
)

2

+
𝜎My,c,d

ft0,d
+ kM ⋅

𝜎Mz,c,d

ft0,d
≤ 1.00

(0.49
1.60

)
2

+ 0.54
1.60

+ 0.5 ⋅ 0
1.60

= 0.43 ≤ 1.00

Shear Design
The design of shear is performed according to [1] 7.4.1.

Design
𝜏Vz,d
fv0,d

= 0.01
0.19

= 0.05 ≤ 1.00

Compression with Buckling Design
The design of compression with buckling follows [1] 7.5:

Design 1 – buckling about y-axis according to 7.5.4
𝜎Nc,d

ft0,d
+

𝜎Md

ft0,d
≤ 1.00

0.49
1.60

+ 0.76
1.60

= 0.78 ≤ 1.00

Design 2 – buckling about z-axis according to 7.5.5
𝜎Nc,d

ft0,d
+

𝜎Md

ft0,d
≤ 1.00

0.49
1.60

+ 0.62
1.60

= 0.69 ≤ 1.00

Lateral-Torsional Buckling Design
The lateral-torsional buckling design is performed according to [1] 7.5.6.

At first, the correction factor, 𝛽M, must be determined.

𝛽M = 1
0.26𝜋

⋅ 𝛽E

𝛾f
⋅

(ℎ
b

)
3
2

(ℎ
b

− 0.63)
1
2

= 1
0.26𝜋

⋅ 4
1.4

⋅
(12 cm

6 cm
)

3
2

(12 cm
6 cm

− 0.63)
1
2

= 8.453

Design

L1
b

= 169 cm
6 cm

= 28.17 ≤
Ec0,ef

𝛽M ⋅ fc,0,d
= 1,092 kN/m2

8.453 ⋅ 1.60 kN/m2
= 80.74
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8.3.2 Serviceability Limit State Design

For the SLS design, we created load combination CO2. We select that load combination in the
Serviceability Limit State tab of Window 1.1 General Data for design, and we make sure that the
deflection limit for Permanent and live actions for usual constructions according to [1] 9.2.1 is set.

Figure 8.11: Window 1.1 General Data

Then we enter member 1 in Window 1.9 Serviceability Data.

Figure 8.12: Window 1.9 Serviceability Data

We do not modify the reference length, but we select only the direction z. The type of beam is set
as Beam by default, which confines the deformation to L/200.
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For the calculation, we change one setting in the Details dialog box, tab Serviceability: The defor-
mation is to be relative to the Undeformed system.

Figure 8.13: Dialog box Details, tab Serviceability

As mentioned in Chapter 8.2, the effective modulus of elasticity Ec0,ef = 1,092 MPa is defined in
RFEM or RSTAB.

The calculation of RFEM or RSTAB gives the maximum deformation in the local z-direction as
uz = 0.776 mm.

Design

uz
L

200

= 0.776 mm
169 cm
200

= 0.09 ≤ 1.00

After the [Calculation], this result of the deformation analysis is displayed in Window 2.1 Design by
Load Case for the Serviceability Limit State Design table item.

Figure 8.14: Window 2.1 Design by Load Case
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